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ABSTRACT 

 

This project presents the design and implementation of a Design, Fabrication and 

Performance Analysis of a Peltier Module-Based CPU Cooling System combined with 

a water-cooled heat sink for efficient thermal management. Modern CPUs generate 

excessive heat during continuous operation, which can affect performance, stability, and 

lifespan. To solve this issue, a thermoelectric cooling method is used where the Peltier 

module transfers heat from the CPU surface to the cooling system based on the Peltier 

effect. One side of the Peltier cools the CPU, while the hot side is attached to a water-

cooled heat sink system to dissipate heat effectively without using any cooling fan. 

Water circulation through the heat sink helps in maintaining a stable and uniform 

temperature, improving overall heat removal efficiency. A temperature monitoring 

system is used to observe real-time CPU temperature and ensure safe operation. This 

setup provides a quiet, compact, and efficient cooling solution compared to traditional 

air-cooling systems. The main goal of this project is to maintain optimal CPU 

temperature, enhance system reliability, and prevent overheating issues in high-

performance computing applications. 
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CHAPTER 1 

INTRODUCTION 
 

1.1  Introduction  

For the past two decades, the miniaturization of electronic devices has been the electronics 

industry's primary research focus. Consequently, smaller devices have higher power densities 

and operate at elevated temperatures, which drastically undermine their performance and 

reduce safety and reliability. Pedram and Nazarian reported that more than 50% of integrated 

circuit failures are related to thermal issues. Thermoelectric cooling can provide enhanced 

cooling rates and address the thermal management challenges of compact electronics. 

Although Peltier modules are available in the market, the current commercial external 

Computer cooling systems (cooler pads) do not employ them and instead rely on only a set of 

axial fans, which cause an inadequate decrement in CPU/GPU junction temperatures. This 

study aimed to develop an effective and practical TEC-based cooling system for laptop 

computers.  

 

Research on the application of TECs for thermal management of electronics began with 

mathematical modeling of TECs and their subsequent performance assessment and 

optimization depending on various parameters. However, little effort has been dedicated to 

incorporating TECs in physically confined electronic devices such as laptops and computers. 

BouRabee et al. used a TEC to cool air and supply it to the fan inlet of a laptop. Temperatures 

of various components in the laptop and Computer were measured at several ventilation 

conditions, with and without the TEC in conjunction. However, since the air cooled by TEC 

was passed through an enclosed ducting, it resulted in a large pressure drop and thereby poor 

convection, resulting in only 1°C temperature drop in the GPU relative to a commercial 

external cooling system. Khan et al. attached a TEC directly to the CPU die, and a secondary 

heat pipe is used to cool the hot side of the module. The final cooling load of the secondary 

heat pipe is borne by the laptops and computers' existing forced convection-cooled heat sink. 

This restricts the TEC from operating at higher cooling capacities, and consequently, the CPU 

junction temperature drop witnessed was only 2.3°C as compared to the stock cooling system. 
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In the present study, a TEC is physically integrated with the stock cooling system, and its 

performance is gauged by the temperature drop produced in CPU/GPU junctions.  

 

1.2 Problem Statement 

Modern computer processors (CPUs) generate a significant amount of heat during high-speed 

and continuous operations. Excessive heat can lead to performance degradation, system 

instability, and permanent hardware damage if not properly managed. Conventional air-

cooling systems that rely on fans often face limitations such as noise, inefficient heat 

dissipation under heavy load, dust accumulation, and reduced cooling performance over time. 

 

Additionally, standard cooling methods may not provide sufficient temperature control for 

high-performance or compact systems. Therefore, there is a need for an alternative cooling 

solution that is more efficient, reliable, and compact. 

 

This project addresses the problem by implementing a Peltier-based thermoelectric cooling 

system combined with a water-cooled heat sink, eliminating the need for traditional cooling 

fans. The system aims to provide better heat transfer, stable temperature control, and silent 

operation. However, challenges such as heat dissipation from the hot side, power 

consumption, and system efficiency must also be considered and optimized for effective 

performance. 

 

1.3 Objectives  

The objectives of this project are: 

 To design and develop an efficient CPU cooling system using a Peltier (thermoelectric) 

module 

 To reduce CPU temperature and prevent overheating during high-performance operation 

 To achieve a compact and noise-free cooling solution compared to traditional air cooling 
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1.4 Project plan 

 

 
 

Figure 1.1 Project Implementation Chart 
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1.5 Methodology 

Our methodology for the project: 

 
 Design and construction of a “Design, Fabrication and Performance Analysis of a 

Peltier Module-Based CPU Cooling System” and designing a block diagram & circuit 

diagram to know which components are needed to construct it.  

 Collecting all components and programming for the microcontroller to control the system. 

 Setting all components in a PCB board & soldering. Then assembling the whole block on 

a board and finally running the system & checking. 
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CHAPTER 2 

THEORY AND BACKGROUND STUDY 
 

2.1 Introduction 

This chapter presents the theoretical background of the Peltier-based CPU cooling system, 

including its working principles and key concepts. It also reviews previous research and 

existing cooling technologies. The literature review helps to understand system design 

improvements, efficiency challenges, and the role of thermoelectric cooling in modern CPU 

temperature management. 

 

2.2 Principle of the Peltier Module  

One of the connections created by the two dissimilar materials may heat up while the other 

cools down when an electric current passes between them. This is referred to as the Peltier 

effect, which is the Seebeck effect in reverse. The Peltier coefficients and the current passing 

through the materials determine how much heat is produced or absorbed. Thus, the Peltier 

effect can be employed as a silent refrigerator without any moving fluid and to pump heat 

from one place to another. Thermoelectric refrigerators are small, green, and safe because they 

don't use dangerous refrigerants. Applications for satellites, spacecraft, dehumidifiers, and 

fiber optics can all benefit from the Peltier effect's cooling properties. 

 

 

Figure 2.1 Peltier Effect 
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A longer lifespan and less maintenance are provided by the absence of mechanical wear and 

moving parts. Since no refrigerants are utilized, there is no issue with leaks. The size and 

shape of the thermoelectric coolers will be flexible. By regulating current, the TEC coolers 

offer precise control over the heat produced or dissipated. Its poor coefficient of performance 

and high cost for a given cooling capacity are its key drawbacks. 

 

2.3 Peltier-Based CPU Cooler 

A Peltier CPU cooler, also known as a thermoelectric cooler, is a device specifically designed 

to dissipate heat generated by a CPU. It utilizes the Peltier effect, discovered by Jean Charles 

Athanase Peltier in 1834, to create a temperature difference between two junctions when an 

electric current flows through two dissimilar materials. This temperature difference allows 

for efficient heat transfer, cooling down the CPU and preventing overheating. 

 

The main component of a Peltier CPU cooler is the Peltier module itself. This module is made 

up of a set of thermoelectric materials, such as bismuth telluride, sandwiched between two 

ceramic plates. When an electric current is applied to the module, one side becomes cold 

while the other becomes hot, creating the desired temperature difference. 

 

One side of the Peltier module, also known as the cold side, is in direct contact with the CPU 

heat source. This side absorbs the heat generated by the CPU, causing the thermoelectric 

materials to cool down. The hot side of the module, on the other hand, faces the external 

environment. It dissipates the absorbed heat into the surroundings using passive or active 

cooling methods, such as a heatsink and a fan, or even liquid cooling systems. 

 

With the Peltier effect at work, the hot side of the Peltier module increases in temperature, 

while the cold side decreases in temperature. This temperature difference allows for efficient 

heat transfer from the CPU to the cold side, ensuring that the CPU operates within safe 

temperature limits. 

 

It’s worth noting that while Peltier CPU coolers can effectively cool down CPUs, they also 

have some limitations. Peltier modules consume a significant amount of electrical power, as 
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they require an electric current to operate. Additionally, Peltier coolers can create a 

substantial amount of heat on the hot side, which needs to be dissipated effectively to prevent 

temperature build-up. 

 

2.4 Literature Review  

Thermoelectric cooling technology is based on the Peltier effect, where heat transfer occurs 

due to electric current flow. This method is widely used for small-scale cooling applications 

because it has no moving parts, operates silently, and requires low maintenance. Researchers 

highlight that thermoelectric modules are compact and environmentally friendly compared to 

traditional refrigeration systems. However, their lower efficiency and high-power 

consumption limit large-scale use. Recent advancements in semiconductor materials have 

improved their performance. This study provides a foundation for applying thermoelectric 

cooling in CPU systems where compact and reliable cooling is required. 

 

Modern CPUs generate localized hotspots due to uneven workload distribution. This study 

explains how thermoelectric coolers can directly target these hotspots for efficient cooling. 

By placing Peltier modules close to the heat source, rapid heat removal is possible. The 

research shows improved CPU performance and reduced thermal stress. However, challenges 

include increased energy consumption and integration complexity. The findings suggest that 

thermoelectric cooling is suitable for high-performance processors when combined with 

effective heat dissipation techniques, such as liquid cooling. 

 

This research reviews both on-chip and off-chip thermoelectric cooling methods used in 

electronic devices. On-chip cooling offers fast response and localized temperature control, 

while off-chip systems are easier to implement. The study highlights that thermoelectric 

cooling has been researched for many years, but is now gaining importance due to 

advancements in nanotechnology. Despite its benefits, efficiency remains a major concern. 

The paper concludes that combining thermoelectric cooling with other cooling methods can 

improve overall performance in CPU applications. 

This study focuses on combining thermoelectric cooling with a water-cooling heat sink. The 

results show that liquid cooling significantly improves heat removal from the hot side of the 
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Peltier module. It ensures stable operation and prevents overheating of the system. The 

experiment also indicates that coolant flow rate and heat exchanger design play an important 

role in performance. This hybrid approach is more efficient than air cooling alone and is highly 

suitable for CPU cooling systems. 

 

This research analyzes a hybrid system combining thermoelectric and liquid cooling methods. 

The system provides rapid heat dissipation and maintains stable CPU temperature under heavy 

load conditions. Optimization techniques are applied to improve cooling efficiency and reduce 

power consumption. The study concludes that proper system design, including a heat sink and 

water flow control, is essential for achieving the best performance. This approach is effective 

for modern computing systems. 

 

This study presents a thermoelectric cooling system designed for multicore processors. It uses 

multiple Peltier modules arranged in an array to cool different regions of the CPU. The system 

dynamically adjusts cooling based on temperature variations. Results show improved thermal 

management and reduced power usage. The research emphasizes the importance of smart 

control systems in improving cooling performance. This method is suitable for advanced CPU 

cooling applications. 

 

Recent research highlights improvements in thermoelectric materials used in Peltier modules. 

New semiconductor materials increase efficiency and cooling capacity. These advancements 

make thermoelectric cooling more practical for electronic devices such as CPUs. The study 

also discusses design improvements and future challenges in thermoelectric systems. It 

suggests that continued research will enhance performance and reduce limitations. 

 

This study explores transient cooling techniques using pulsed current in thermoelectric 

modules. It shows that temporary cooling below normal limits can be achieved. This method 

is useful for handling sudden temperature spikes in CPUs. However, continuous operation at 

such levels is difficult due to energy limitations. The research highlights potential 

improvements in cooling efficiency for short-duration high-load conditions. 
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This research discusses the real-world implementation of Peltier cooling systems. It shows 

that combining thermoelectric cooling with water cooling can achieve low temperatures 

effectively. However, the system requires careful design to handle heat from the hot side. High 

power consumption and system complexity are major challenges. The study provides practical 

insights into designing efficient cooling systems. 

 

This study focuses on the limitations of thermoelectric cooling systems. It explains that low 

efficiency and high energy consumption are major drawbacks. The heat generated on the hot 

side must be properly dissipated to maintain performance. Without effective cooling, the 

system may fail. The study emphasizes the need for improved design and hybrid cooling 

techniques. 
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CHAPTER 3 

SYSTEM ARCHITECTURE 

 

3.1 Introduction  

The project objectives, methods, Peltier Concept, literature evaluation, and other details were 

all clarified in the preceding chapter. The block diagram, circuit diagram, working principle, 

Hardware Implementation, and final project instrument cost analysis will all be covered in 

this chapter. 

 

3.2 Block Design  

Here is the block diagram of the “CPU Cooling System using Peltier” with all the essential 

components. All of the components are shown below as a block in this diagram. Here we use 

the Arduino nano Micro-controller of our project. Other equipment is attached to this 

microcontroller and works together to perform as our desired outcome. 

 

 
 

Figure 3.1: Block Diagram of CPU Cooling System using Peltier 
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3.3 Schematic Design  

The schematic diagram here represents the electrical circuit and the components of the project. 

Here we have used standardized symbols and lines. 

 

 
 
 

Figure 3.2: Circuit Diagram CPU Cooling System using Peltier 

 

3.4 Working Principle 

 The system is powered by an SMPS, which supplies a stable DC voltage to all 

components, including the Arduino Nano, Peltier module, sensors, relay, and pump 

motor. 

 A temperature sensor continuously measures the CPU temperature and sends real-time 

data to the Arduino Nano, which acts as the main controller. 

 The Arduino Nano processes the temperature data and displays it on the LCD for user 

monitoring. 

 When the temperature exceeds a preset limit, the Arduino activates the relay module, 

which switches ON the Peltier module and pump motor. 
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 The Peltier module works on the thermoelectric effect: one side becomes cold (placed on 

the CPU) and absorbs heat, while the backside becomes hot. 

 To remove this heat, a water-cooling heat sink is attached to the hot side. The pump motor 

circulates water through the heat sink, carrying away heat and cooling the hot surface. 

 The system may also use a heater (for testing or control purposes) to simulate temperature 

rise. 

 Once the temperature drops below the set limit, the Arduino turns OFF the relay, stopping 

the Peltier and pump, maintaining efficient and controlled cooling. 

 

3.5 Project Experimental Setup 

 

 
 

Figure 3.3: Hardware and Instrument Setup 
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3.6 Cost Management 

Table 01: Cost Analysis 
 

No. Product Name Specification Qty. 
Price 

Unit Price 
(Taka) 

Total Price 
(Taka) 

01 SMPS 5V 7Amp 1 600 600 

02 Heater 220V 200W 1 700 700 

03 Peltier TEC1-12706 2 400 800 

04 Water Cooling 
Heat Sink  

Aluminium 
40*80*12mm 

1 600 600 

05 Relay 5V 3 150 450 

06 Arduino Nano ATmega328p 1 700 700 

07 LCD Display 16*2 1 450 450 

08 Pump Motor 6v DC 1 250 250 

09 Temperature 
Sensor  

DS18B20 1 300 300 

10 Others    2000 

    Total = 6850/= 
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CHAPTER 4 

HARDWARE AND SOFTWARE ANALYSIS 

 

4.1 Introduction  

In this section, we will discuss elaborately about “CPU Cooling System using Peltier” and the 

component description, features, and working procedure of all equipment. The system 

hardware fabricates composed of micro-controller unit, a power unit, a source unit, power 

store unites, a sensor unit, and many more related components.  

 

4.2 Hardware Instrument  

 SMPS 

 Arduino Nano 

 Peltier Module 

 Water Cooling Heat Sink 

 Pump Motor 

 Heater 

 LCD Display 

 Temperature Sensor 

 Relay 

 

4.3 Switch Mode Power Supply (SMPS) 

A switched-mode power supply (switching-mode power supply, switch-mode power 

supply, switched power supply, SMPS, or switcher) is an electronic power supply that 

incorporates a switching regulator to convert electrical power efficiently. Unlike a linear 

power supply, the pass transistor of a switching-mode supply continually switches between 

low-dissipation, full-on and full-off states, and spends very little time in the high-dissipation 

transitions, which minimizes wasted energy. A hypothetical ideal switched-mode power 

supply dissipates no power. Voltage regulation is achieved by varying the ratio of on-to-off 

time (also known as duty cycles). In contrast, a linear power supply regulates the output 
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voltage by continually dissipating power in the pass transistor. This higher power conversion 

efficiency is an important advantage of a switched-mode power supply.  

 

 

Figure 4.1:  Switch Mode Power Supply (SMPS) 

 

Switching regulators are used as replacements for linear regulators when higher efficiency, 

smaller size, or lighter weight are required. They are, however, more complicated; their 

switching currents can cause electrical noise problems if not carefully suppressed, and simple 

designs may have a poor power factor. Switched-mode power supplies are classified 

according to the type of input and output voltages. The four major categories are: 

 AC to DC 

 DC to DC 

 DC to AC 

 AC to AC 

 
A basic isolated AC to DC switched-mode power supply consists of: 

 Input rectifier and filter 

 Inverter consisting of switching devices such as MOSFETs 

 Transformer 

 Output rectifier and filter 

 Feedback and control circuit 

 

The input DC supply from a rectifier or battery is fed to the inverter, where it is turned on and 

off at high frequencies of between 20 KZ and 200 KZ by the switching MOSFET or power 



 16 

transistors. The high-frequency voltage pulses from the inverter are fed to the transformer 

primary winding, and the secondary AC output is rectified and smoothed to produce the 

required DC voltages. A feedback circuit monitors the output voltage and instructs the control 

circuit to adjust the duty cycle to maintain the output at the desired level. 

 
Basic working concept of an SMPS 

A switching regulator does the regulation in the SMPS. A series switching element turns the 

current supply to a smoothing capacitor on and off. The voltage on the capacitor controls the 

time the series element is turned on. The continuous switching of the capacitor maintains the 

voltage at the required level. 

 

Design basics 

AC power first passes through fuses and a line filter. Then it is rectified by a full-wave bridge 

rectifier. The rectified voltage is next applied to the power factor correction (PFC) pre-

regulator, followed by the downstream DC-DC converter(s). Most computers and small 

appliances use the International Electrotechnical Commission (IEC) style input connector. As 

for output connectors and pinouts, except for some industries, such as PC and compact PCI, 

in general, they are not standardized and are left up to the manufacturer. There are different 

circuit configurations known as topologies, each having unique characteristics, advantages, 

and modes of operation, which determine how the input power is transferred to the output. 

Most of the commonly used topologies, such as flyback, push-pull, half bridge, and full 

bridge, consist of a transformer to provide isolation, voltage scaling, and multiple output 

voltages. The non-isolated configurations do not have a transformer, and the power conversion 

is provided by the inductive energy transfer. 

 
Advantages of switched-mode power supplies 

 Higher efficiency of 68% to 90% 

 Regulated and reliable outputs regardless of variations in input supply voltage 

 Small size and lighter 

 Flexible technology 

 High power density 
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Disadvantages 

 Generates electromagnetic interference 

 Complex circuit design 

 Expensive compared to linear supplies 

 
Switched-mode power supplies are used to power a wide variety of equipment, such as 

computers, sensitive electronics, battery-operated devices, and other equipment requiring 

high efficiency. 

 
Switch Mode Power Supply 

 

Figure 4.2: SMPS Circuit Diagram 

 

Linear voltage IC regulators have been the basis of power supply designs for many years, as 

they are very good at supplying a continuous fixed voltage output. Linear voltage regulators 

are generally much more efficient and easier to use than equivalent voltage regulator circuits 

made from discrete components, such as a Zener diode and a resistor, or transistors and even 

op-amps. The most popular linear and fixed output voltage regulator types are, by far, the 

positive output voltage series and the negative output voltage series. These two types of 

complementary voltage regulators produce a precise and stable voltage output ranging from 

about 5 volts up to about 24 volts for use in many electronic circuits. There is a wide range of 

these three-terminal fixed voltage regulators available, each with its own built-in voltage 

regulation and current limiting circuits.  
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This allows us to create a whole host of different power supply rails and outputs, either single 

or dual supply, suitable for most electronic circuits and applications. There are even variable 

voltage linear regulators available as well, providing an output voltage that is continually 

variable from just above zero to a few volts below its maximum voltage output. Most D.C. 

power supplies comprise a large and heavy step-down mains transformer, diode rectification, 

either full-wave or half-wave, and a filter circuit to remove any ripple content from the 

rectified d.c. producing a suitably smooth d.c. voltage, and some form of voltage regulator or 

stabilizer circuit, either linear or switching, to ensure the correct regulation of the power 

supply's output voltage under varying load conditions. Then a typical d.c. Power supply would 

look something like this: 

 

Typical DC Power Supply 

 

 

 

 
Figure 4.3: DC Power Supply 

 

These typical power supply designs contain a large mains transformer (which also provides 

isolation between the input and output) and a dissipative series regulator circuit. The regulator 

circuit could consist of a single Zener diode or a three-terminal linear series regulator to 

produce the required output voltage. The advantage of a linear regulator is that the power 

supply circuit only needs an input capacitor, an output capacitor, and some feedback resistors 

to set the output voltage. 
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4.4 Relay 

A relay is an electrically operated switch. Many relays use an electromagnet to mechanically 

operate a switch, but other operating principles are also used, such as solid-state relays. Relays 

are used where it is necessary to control a circuit by a separate low-power signal, or where 

several circuits must be controlled by one signal. The first relays were used in long-

distance telegraph circuits as amplifiers: they repeated the signal coming in from one circuit 

and re-transmitted it on another circuit. Relays were used extensively in telephone exchanges 

and early computers to perform logical operations. 

 

 

 

Figure 4.4: Relay 

 

A type of relay that can handle the high power required to directly control an electric motor 

or other loads is called a contactor. Solid-state relays control power circuits with no moving 

parts, instead using a semiconductor device to perform switching. Relays with calibrated 

operating characteristics and sometimes multiple operating coils are used to protect electrical 

circuits from overload or faults; in modern electric power systems, these functions are 

performed by digital instruments still called "protective relays".  

 

Magnetic latching relays require one pulse of coil power to move their contacts in one 

direction, and another, redirected pulse to move them back. Repeated pulses from the same 

input have no effect. Magnetic latching relays are useful in applications where interrupted 

power should not be able to transition the contacts. 
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Magnetic latching relays can have either single or dual coils. On a single-coil device, the relay 

will operate in one direction when power is applied with one polarity, and will reset when the 

polarity is reversed. On a dual coil device, when polarized voltage is applied to the reset coil, 

the contacts will transition. AC-controlled magnetic latch relays have single coils that employ 

steering diodes to differentiate between operate and reset commands. 

 
The relay module is the one in the figure below. 

 

Figure 4.5: Relay Module. 

 

This module has two channels (those blue cubes). There are other varieties with one, four, and 

eight channels. 

Main’s voltage connections. 

In relation to mains voltage, relays have 3 possible connections: 

 

 

Figure. 4.6: Main’s voltage connections. 
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 COM: common pin 

 NO (Normally Open): There is no contact between the common pin and the normally 

open pin. So, when you trigger the relay, it connects to the COM pin, and a supply is 

provided to a load 

 NC (Normally Closed): There is contact between the common pin and the normally 

closed pin. There is always a connection between the COM and NC pins, even when the 

relay is turned off. When you trigger the relay, the circuit is opened, and there is no supply 

provided to a load. 

 

Pin wiring 

The connections between the relay module and the Arduino are really simple: 

 

 

Figure 4.7: voltage connections 

 

 GND: goes to ground 

 IN1: controls the first relay (it will be connected to an Arduino digital pin) 

 IN2: controls the second relay (it should be connected to an Arduino digital pin if 

you are using this second relay; otherwise, you don’t need to connect it) 

 VCC: goes to 5V 
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4.5 LCD Display 

The LCD (liquid crystal display) screen is an electronic display module and looks for various 

applications. A 16x2 LCD is a very basic module, and it is very commonly used in various 

devices and circuits. These modules are preferred over seven sections and many other 

segments. 

 

 

Figure 4.8: 16*2 LCD Display 

 
The reasons for having LCD are economic; Easily programmable, special, and even custom 

characters (different in seven sections), there are no restrictions on displaying animations. A 

16x2 LCD means it can display 16 characters per line and contains 2 lines. Each character on 

this LCD is displayed in a 5x7 pixel matrix. 

 

 
 

Figure 4.9: Pin out of 16*2 LCD Display 

 

This LCD contains two articles called Command and Data. The command register stores the 

command instructions on the LCD. The command is a command given to the LCD to perform 

a predefined task, such as starting it, clearing its screen, locating the cursor, controlling the 

display, etc. 
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Figure 4.10: 16*2 LCD Display interfacing with Arduino 

 
Feature 

The features of this LCD mainly include the following. 

 The operating voltage of this LCD is 4.7V-5.3V 

 It includes two rows where each row can produce 16-characters. 

 The utilization of current is 1mA with no backlight 

 Every character can be built with a 5×8-pixel box 

 The alphanumeric LCDs' alphabet & numbers 

 

4.6 Arduino Nano 

Arduino is an open-source electronics prototyping platform based on flexible, easy-to-use 

hardware and software. It's intended for artists, designers, hobbyists, and anyone interested in 

creating interactive objects or environments. Arduino can sense the environment by receiving 

input from a variety of sensors and can affect its surroundings by controlling Lights, motors, 

and other actuators. 

.  
Figure 4.11: Arduino Nano  
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The microcontroller on the board is programmed using the Arduino programming language 

(based on Wiring) and the Arduino development environment (based on Processing). Arduino 

projects can be stand-alone, or they can communicate with software running on a computer 

(e.g., Flash, Processing, MaxMSP). Arduino Nano is a surface-mount breadboard-embedded 

version with integrated USB. It is a small, complete, and breadboard-friendly component. It 

has everything that Decimal/ Duemilanove has (electrically), with more analog input pins and 

an onboard +5V AREF jumper. Physically, it is missing a power jack. The Nano can 

automatically sense and switch to the higher potential source of power.  

 

 
 

 Figure 4.12: Arduino Nano Schematic Diagram 

 

Nanos got the breadboard-ability of the Boarding and the Minibus with a smaller footprint 

than either, so users have more breadboard space. It’s got a pin layout that works well with 

the Mini or the Basic Stamp (TX, RX, ATN, and GND on one top, power and ground on the 

other). This new version 3.0 comes with ATMEGA328, which offers more programming and 

data memory space. It has two layers. That makes it easier to hack and more affordable. One 

of the best features of Arduino Nano is that it’s easy to use, compact, and small. 
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Figure 4.13: How Arduino Nano looks 

 

Specifications 

 Microcontroller: Atmel ATmega328  

 Operating Voltage (logic level): 5 V  

 Input Voltage (recommended): 7-12 V  

 Input Voltage (limits): 6-20 V  

 Digital I/O Pins: 14 (of which 6 provide PWM output)  

 Analog Input Pins: 8  

 DC Current per I/O Pin: 40 mA  

 Flash Memory: 32 KB (of which 2KB is used by the boot loader)  

 SRAM : 2 KB  

 EEPROM: 1 KB  

 Clock Speed: 16 MHz  

 Dimensions: 0.70” x 1.70” 

 
Features 

 Automatic reset during program download  

 Power OK blue LED  

 Green (TX), red (RX), and orange (L) LED  

 Auto-sensing/switching power input  

 Small mini-B USB for programming and serial monitor  

 ICSP header for direct program download 

 Manual reset switch  
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4.7 Peltier Module  

A Peltier cooler, heater, or Thermoelectric heat pump is a solid-state active heat pump that 

transfers heat from one side of the device to the other, with the consumption of electrical 

energy, depending on the direction of the current. 

 

 
 

Figure 4.14: Peltier Module 

 

The TEC1-12706 40x40mm Thermoelectric Cooler 0~6A Peltier Module is the simple 

application of the Peltier Thermoelectric Effect. Thermoelectric coolers, also known as TEC 

or Peltier modules, create a temperature differential on each side. One side gets hot, and the 

other side gets cool. Therefore, they can be used to either warm something up or cool 

something down, depending on which side you use. You can also take advantage of a 

temperature differential to generate electricity. 

 
Two unique semiconductors, one n-type and one p-type, are used because they need to have 

different electron densities. The semiconductors are placed thermally in parallel to each other 

and electrically in series, and then joined with a thermally conducting plate on each side. 

When a voltage is applied to the free ends of the two semiconductors, there is a flow of DC 

across the junction of the semiconductors, causing a temperature difference. The side with the 

cooling plate absorbs heat, which is then moved to the other side of the device, where the heat 
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sink is. Thermoelectric Coolers, also abbreviated to TECs, are typically connected side by 

side and sandwiched between two ceramic plates.  

 

 

 

 

Figure 4.15: Construction of Peltier 

 
The cooling ability of the total unit is then proportional to the number of TECs in it. This 

Peltier works very well as long as you remove the heat from the hot side. After turning on the 

device, the hot side will heat quickly, and the cold side will cool quickly. If you do not remove 

the heat from the hot side (with a heat sink or other device), the Peltier will quickly reach 

stasis and do nothing. We recommend using an old computer CPU heatsink or another block 
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of metal to pull heat from the hot side. We were able to use a computer power supply and 

CPU heat sink to make the cold side so uncomfortable that we could not hold our finger to it. 

A Thermoelectric cooling (TEC) module is a semiconductor-based electronic component that 

functions as a small heat pump. By applying the DC power source to a TEC, heat will be 

transferred from one side of the module to the other. It creates a cold and a hot side. They are 

widely used in industrial areas, for example, computer CPUs, CCDs, portable refrigerators, 

medical instruments, and so on. Also known as Thermoelectric cooling modules, 

Thermoelectric modules, Peltier modules, Thermoelectric cooling module. 

 

Features 

 Small module. 

 Easy transition between the hot side and the cool side and vice versa, just by reversing 

the polarity of the supply. 

 Quality-tested cooling cells. 

 Solid state, vibration-free, noise-free. 

 Simple to install and operate. 

 Should be used with a heat sink. 

 

4.8 Water Cooling Heat Sink   

A heat sink (also commonly spelled heat sink) is a passive heat exchanger that transfers the 

heat generated by an electronic or mechanical device to a fluid medium, often air or a liquid 

coolant, where it is dissipated away from the device, thereby allowing regulation of the 

device's temperature. In computers, heat sinks are used to cool CPUs, GPUs, and some 

chipsets and RAM modules. Heat sinks are used with high-power semiconductor devices such 

as power transistors and optoelectronics such as lasers and light-emitting diodes (LEDs), 

where the heat dissipation ability of the component itself is insufficient to moderate its 

temperature. 
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Figure 4.16: Water Cooling Heat Sink  

 
Features 

 Aluminum Water Cooling Block for CPU Heat sink Cooler Peltier Plate 80x40x12mm 

 Internal flow channel extrusion forming 

 Brazing parts into a whole 

 Leak rate of less than 5X10-6 mbar.l/s parts 

 Internal fin thickness 0.5MM 

 Connection: 9 mm ID tubes 

 Processing: vacuum aluminum brazing 

 Surface treatment: silver oxidation 

 Applicable to computer CPU water, industrial inverter driver, laser head cooling, 

industrial control cabinet cooling, and Thermoelectric Cooler 

 Size:80 (D) x 40 (W) x 12 (H) MM 

 

4.9  Pump Motor 

This is a low-cost, small-sized Submersible Pump Motor which can be operated from a 2.5 ~ 

6V power supply. It can take up to 120 liters per hour with very low current consumption of 

220mA. Just connect the tube pipe to the motor outlet, submerge it in water, and power it. 

Make sure that the water level is always higher than the motor. A dry run may damage the 

motor due to heating, and it will also produce noise. 
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Figure 4.17: Pump Motor 

 

Features 

 Operating Current: 130 ~ 220mA 

 Flow Rate: 80 ~ 120 L/H 

 Maximum Lift: 40 ~ 110 mm 

 Continuous Working Life: 500 hours 

 Driving Mode: DC, Magnetic Driving 

 Material: Engineering Plastic 

 Outlet Outside Diameter: 7.5 mm 

 Outlet Inside Diameter: 5 mm 

 

4.10 Heating Plate 

The aluminum heating plates are commonly used for small-scale heating applications. Each 

plate features a flat metal surface designed to distribute heat evenly when powered. The plates 

are equipped with insulated wire terminals with ring connectors, allowing easy electrical 

connections to an AC power source, typically 220V. A mounting hole is provided on each 

plate for secure placement within a system, such as inside a heating chamber. These plates 

are ideal for projects like the Bottle Heating and Cooling System, where direct surface contact 

is needed to efficiently transfer heat to a container, such as an aluminum bottle. Their compact 

design, durability, and stable heat output make them suitable for domestic, DIY, and low-

power industrial heating solutions. 
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Figure 4.18: Heating Plate 

 

Features 

 Material: Made of high-quality aluminum for fast and even heat conduction. 

 Voltage Rating: Operates typically at AC 220V, suitable for standard power sources. 

 Flat Surface: Ensures uniform heat distribution across the contact area. 

 Compact Design: Small and lightweight, ideal for compact heating systems. 

 Mounting Hole: Built-in hole for easy installation and secure mounting. 

 Wire Connectors: Comes with insulated wires and ring terminals for safe electrical 

connections. 

 Quick Heating: Heats up quickly, making it efficient for small-scale applications. 

 Durable Build: Resistant to corrosion and high temperatures. 

 Low Maintenance: Simple structure with minimal upkeep requirements. 

 

4.11 Waterproof Temperature Sensor 

This product is the waterproof version of the DS18B20 temperature sensor, specifically 

designed for temperature measurements in distant or humid environments. This temperature 

& humidity sensor has a wide temperature range of -55°C to 125°C, but we recommend 

keeping the included PVC jacketed cable below 100°C to ensure optimal performance and 

durability. 
 

The DS18B20 waterproof temperature sensor is a digital sensor that maintains signal integrity 

even over long distances. It utilizes a 1-Wire interface, connecting to a central microprocessor 
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through a single wire (along with a ground wire). This design simplifies installation and 

connection, making it particularly suitable for systems operating within the 3V~5.5V range. 

Each DS18B20 temperature sensor has a unique silicon serial number, useful for verifying its 

authenticity and enabling the connection of multiple sensors on a single 1-Wire bus. This 

feature facilitates the installation of temperature sensors in various locations for applications 

like indoor temperature monitoring, smart home integration, object temperature detection, 

greenhouse farming, and more. 

 
 

 
Figure 4.19: Waterproof Temperature Sensor 

 

Features 

  The probe is based on the DS18B20 chip. 

  High-quality stainless steel tube encapsulation waterproof moisture proof prevent rust. 

  Stainless steel shell 6*50mm. 

  Power supply range: 3.0V to 5.5V. 

  Operating temperature range: -55°C to +125°C (-67°F to +257°F). 

  Storage temperature range: -55°C to +125°C (-67°F to +257°F). 

  Accuracy over the range of -10°C to +85°C: ±0.5°C. 

  No other components required, working directly with the One Wire data protocol. 

  Output lead: red (VCC), yellow(DATA), black(GND). 

  Cable length: 50 cm. 
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4.12 Software   

 Arduino Software IDE  

 Easy EDA 

 

4.13 Arduino Software IDE 

The digital microcontroller unit named Arduino Nano can be programmed with the Arduino 

software IDE. There is no requirement to install any other software other than Arduino. Firstly, 

select "Arduino Nano from the Tools, Board menu (according to the microcontroller on our 

board). The IC used, named ATmega328 on the Arduino Nano, comes pre-burned with a boot 

loader that allows us to upload new code to it without the use of an external hardware 

programmer. 

Communication is using the original STK500 protocol (reference, C header files). We can 

also bypass the boot loader and program the microcontroller through the ICSP (In-Circuit 

Serial Programming) header. The ATmega16U2 (or 8U2 in the rev1 and rev2 boards) 

firmware source code is available. The ATmega16U2/8U2 is loaded with a DFU boot loader, 

which can be activated by: 

On Rev1 boards: connecting the solder jumper on the back of the board (near the map of Italy) 

and then resetting the 8U2. On Rev2 or later boards, there is a resistor that pulls the 8U2/16U2 

HWB line to ground, making it easier to put into DFU mode. The Arduino Nano is one of the 

latest digital microcontroller units and has several facilities for communicating with a 

computer, another Arduino, or other microcontrollers. The ATmega328 provides UART TTL 

at (5V) with serial communication, which is available on digital pins 0 (RX) for receiving data 

and pin no.1 (TX) for transmitting data. An ATmega16U2 on the board channels this serial 

communication over USB and appears as a virtual COM port to software on the computer. 

The '16U2 firmware uses the standard USB COM drivers, and no external driver is needed. 

However, on Windows, an .in file is required. The Arduino software includes a serial monitor, 

which allows simple textual data to be sent to and from the Arduino board. 

The RX and TX LEDs on the board will flash when data is being transmitted via the USB-to-

serial chip and USB connection to the computer (but not for serial Communication on pins 0 

and 1). A Software Serial library allows for serial communication on any of the Nano's digital 
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pins. The ATmega328 also supports I2C (TWI) and SPI communication. The Arduino 

software includes a Wire library to simplify use of the I2C bus. Arduino programs are written 

in C or C++, and the program code written for Arduino is called a sketch. The Arduino IDE 

uses the GNU tool chain and AVR Lab to compile programs, and for uploading the programs 

it uses argued. As the Arduino platform uses Atmel micro-controllers, Atmel's development 

environment, AVR Studio or the newer Atmel Studio, may also be used to develop software 

for the Arduino. 

 

Figure 4.20: Arduino Software Interface IDE  

 
The Arduino Integrated Development Environment - or Arduino Software (IDE) - contains a 

text editor for writing code, a message area, a text console, a toolbar with buttons for common 

functions, and a series of menus. It connects to the Arduino and Genuino hardware to upload 

programs and communicate with them. 

 
Writing Sketches 

Programs written using Arduino Software (IDE) are called sketches. These sketches are 

written in the text editor and are saved with the file extension .ion. The editor has features for 

cutting/pasting and for searching/replacing text. The message area gives feedback while 

saving and exporting, and also displays errors. The console displays text output by the Arduino 

Software (IDE), including complete error messages and other information. The bottom right-
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hand corner of the window displays the configured board and serial port. The toolbar buttons 

allow you to verify and upload programs, create, open, and save sketches, and open the serial 

monitor. 

 

Upload Using Programmer 

This will overwrite the boot loader on the board; you will need to use Tools > Burn Boot 

Loader to restore it and be able to upload to the USB serial port again. However, it allows you 

to use the full capacity of the Flash memory for your sketch. Please note that this command 

will NOT burn the fuses. To do so, a Tools -> Burn Boot Loader command must be executed. 

 

Sketchbook 

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store your 

programs (or sketches). The sketches in your sketchbook can be opened from the File > 

Sketchbook menu or from the Open button on the toolbar. The first time you run the Arduino 

software, it will automatically create a directory for your sketchbook. You can view or change 

the location of the sketchbook from within the Preferences dialog. Beginning with version 

1.0, files are saved with a .ino file extension. Previous versions use the .pde extension. You 

may still open .pde named files in version 1.0 and later, the software will automatically rename 

the extension to .ino. 

 

Tabs, Multiple Files, and Compilation 

Allows you to manage sketches with more than one file (each of which appears in its own 

tab). These can be normal Arduino code files (no visible extension), C files (.c extension), 

C++ files (.cpp), or header files (.h). 

 

Uploading 

Before uploading your sketch, you need to select the correct items from the Tools > Board 

and Tools > Port menus. The boards are described below. On the Mac, the serial port is 

probably something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) or 

/dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or 

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Key span USB-to-Serial 
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adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, COM5, 

COM7, or higher (for a USB board) - to find out, you look for a USB serial device in the ports 

section of the Windows Device Manager. On Linux, it should be /dev/ttyACMx, 

/dev/ttyUSBx, or similar. Once you've selected the correct serial port and board, press the 

upload button in the toolbar or select the Upload item from the Sketch menu. Current Arduino 

boards will reset automatically and begin the upload. With older boards (pre-Decimal) that 

lack auto-reset, you'll need to press the reset button on the board just before starting the upload. 

On most boards, you'll see the RX and TX LEDs blink as the sketch is uploaded. The Arduino 

Software (IDE) will display a message when the upload is complete or show an error. 

 

When you upload a sketch, you're using the Arduino boot loader, a small program that has 

been loaded onto the microcontroller on your board. It allows you to upload code without 

using any additional hardware. The boot loader is active for a few seconds when the board 

resets; then it starts whichever sketch was most recently uploaded to the microcontroller. The 

boot loader will blink the on-board (pin 13) LED when it starts (i.e., when the board resets). 

 

Libraries 

Libraries provide extra functionality for use in sketches, e.g., working with hardware or 

manipulating data. To use a library in a sketch, select it from the Sketch > Import Library 

menu. This will insert one or more #include statements at the top of the sketch and compile 

the library with your sketch. Because libraries are uploaded to the board with your sketch, 

they increase the amount of space it takes up. If a sketch no longer needs a library, simply 

delete its #include statements from the top of your code. 

 

There is a list of libraries in the reference. Some libraries are included with the Arduino 

software. Others can be downloaded from a variety of sources or through the Library Manager. 

Starting with version 1.0.5 of the IDE, you can import a library from a zip file and use it in an 

open sketch. See these instructions for installing a third-party library. 

 

 

Third-Party Hardware 
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Support for third-party hardware can be added to the hardware directory of your sketchbook 

directory. Platforms installed there may include board definitions (which appear in the board 

menu), core libraries, boot loaders, and programmer definitions. To install, create the 

hardware directory, then unzip the third-party platform into its own subdirectory. (Don't use 

"Arduino" as the sub-directory name, or you'll override the built-in Arduino platform.) To 

uninstall, simply delete its directory. 

 

For details on creating packages for third-party hardware, see the Arduino IDE 1.5 3rd party 

Hardware specification. 

 

Serial Monitor 

This displays serial sent from the Arduino or Genuino board over USB or serial connector. To 

send data to the board, enter text and click on the "send" button or press enter. Choose the 

baud rate from the drop-down menu that matches the rate passed to Serial. Begin in your 

sketch. Note that on Windows, Mac, or Linux, the board will reset (it will rerun your sketch) 

when you connect with the serial monitor. Please note that the Serial Monitor does not process 

control characters; if your sketch needs complete management of the serial communication 

with control characters, you can use an external terminal program and connect it to the COM 

port assigned to your Arduino board. You can also talk to the board from Processing, Flash, 

MaxMSP, etc (see the interfacing page for details). 

 

4.14 Easy EDA Software 

Easy EDA is a web-based EDA tool suite that enables hardware engineers to design, simulate, 

share publicly and privately, and discuss schematics, simulations, and printed circuit boards. 

Other features include the creation of a bill of materials, Gerber files, pick and place files, and 

documentary outputs in PDF, PNG, and SVG formats. Easy EDA allows the creation and 

editing of schematic diagrams, SPICE simulation of mixed analogue and digital circuits, and 

the creation and editing of printed circuit board layouts and, optionally, the manufacture of 

printed circuit boards. 
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Figure 4.21: Easy EDA Software Interface 

 

Subscription-free membership is offered to the public, plus a limited number of private 

projects. The number of private projects can be increased by contributing high-quality public 

projects, schematic symbols, and PCB footprints, and/or by paying a monthly subscription. 

Registered users can download Gerber files from the tool free of charge, but for a fee, 

EasyEDA offers a PCB fabrication service. This service is also able to accept Gerber file 

inputs from third-party tools. 
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CHAPTER 5 

RESULT AND DISCUSSION 

5.1 Data Analysis  

 Peltair Key Specifications:  
Model TEC1-12706 

Dimensions 40x40x4 mm 

Operating Voltage 12V DC 

Maximum Current 6A 

Power ~60W 

Weight 0.027 kg 
Specific Heat(J/Kg-K) 154.4  

[11] 
 

Reading 
Time( Second) Temperature( Celcious) 

0 39.7 
30 36.2 
60 34.1 

 
Temperature Difference (∆𝑡)= ( 39.7-34.1) ℃ = 5.6 K   
Total time, t = 60 Second. 

Steel plate dimension= 17.8 cm ×17.5 cm ×0.4 cm 

 
 Volume of steel plate = (0.178×0.175×0.004) m3  

                                                      = 0.0001246 m3 

 
Density of steel, 𝜌 = 7850 kg/m3  
Mass of steel plate, m = v×𝜌  
   = 0.0001246 × 7850 kg 
   = 0.97811 kg  

 

Specific Heat  of steel, CP = 500 J/kg-K  
                                        = 0.5  kJ/kg-K 

 

Amount of Heat Energy Transferred  Q = m×CP× ∆𝑡 
    = 0.97811 × 0.5  × 5.6  kJ 
    = 2.7387 kJ 
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Rate of Heat Energy Transferred           = 2.7387 ÷ 60 kW (Q/t) 
          = 0.0456 kW 

 

Power consumption (Peltair),  pp          = V×I 
       = 12 × 6 W 
       = 72 W 

  = 72×2 W ( number of peltair 02) 
  = 144  W 
  = 0.144 kW 

 
Power consumption (pump-motor),  ppm  = V×I 
          = 6 × 1.5 W 
          = 9 W 

     =0.009 kW 
Total Power consumption , pt                  =  pp + ppm 

            = 0.144+ 0.009 kW 
          = 0.153 kW 
 

The Coefficient of Performance (COP)peltair  =  
ொ

௉
 

      = 
଴.଴ସହ଺

଴.ଵସସ
 

      = 0.316  

 Peltair (model:TEC1-12706) cop range= 0.3 to 0.7 [12]  
 

The Coefficient of Performance (COP)total   =  
ொ

௉
 

              = 
଴.଴ସହ଺

଴.ଵହଷ
 

              = 0.298 
 
 

 Project Outcome 

Our project is a Three-Phase Transmission Line Fault Detection System. In our project making 

we used PVC boards for the total hardware making. After finally completing this project, we 

ran it & we observed the output of this project. We can see that it is working well as expected. 

After making our project, we observe it very carefully. It works as we desire. Our project gives 

output perfectly, and all the equipment works perfectly.  

  

 The system successfully reduced CPU temperature compared to 

  normal conditions, showing effective cooling performance. 
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 The Peltier module provided rapid cooling on the CPU surface, maintaining a stable 

temperature during operation. 

 The water-cooling heat sink efficiently removed heat from the hot side of the Peltier, 

improving overall system efficiency. 

 The system operated without any cooling fan, resulting in silent operation and reduced 

noise. 

 The temperature sensor and LCD provided accurate real-time temperature monitoring. 

 The Arduino Nano with relay control ensured automatic switching, improving system 

control and safety. 

 Continuous water circulation using a pump motor maintained uniform cooling and 

prevented overheating. 

 The system demonstrated compact design and suitability for small-scale CPU cooling 

applications. 

 However, the higher power consumption of the Peltier module was observed as a 

limitation. 

Overall, the project proved that a Peltier-based water-cooling system is an effective alternative 

to conventional air-cooling methods. 

 

5.2 Advantages 

There are certainly many advantages of our project, and some of the major ones have been 

given below: 

 Provides efficient and fast cooling of the CPU 

 Silent operation (no cooling fan used) 

 Compact and lightweight design 

 Better heat dissipation using water cooling heat sink 

 Automatic temperature control with Arduino 

 Real-time temperature monitoring using LCD 

 Reduces the risk of CPU overheating and damage 

 Less maintenance compared to air cooling (no dust issue)y 
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5.3 Applications  

Our project has many application areas. Some of the application areas of the project have been 

pointed out below: 

 
 High-performance desktop computers, laptops, and gaming PCs 

 Industrial control systems and automation panels 

 Electronics testing and research laboratories 

 Medical and precision electronic equipment 

 

5.4 Limitations 

Though this project has many advantages, it has some limitations as well, and they are listed 

below 

 High power consumption of the Peltier module 

 Risk of water leakage in the system 

 The initial setup cost can be higher 

 Not suitable for large-scale or heavy-duty cooling without optimization 

 It cannot detect gas leaks 

 

5.5 Discussion 

While working on our project, we did face some difficulties as it is a very complex system, 

but the results we came up with were quite satisfactory. We have put the whole system through 

several tasks to validate our work and also have taken necessary notes for future 

improvements. Some future recommendations that we have involve improvement in system 

design and wiring, and adding features for more efficiency. 

 

This project demonstrates an alternative approach to CPU cooling by integrating a Peltier 

module with a water-cooling heat sink system. The results show that effective temperature 

reduction can be achieved without using a conventional cooling fan, ensuring silent operation. 

The use of water circulation improves heat dissipation from the hot side of the Peltier, 

enhancing overall efficiency. However, the system also highlights challenges such as high-
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power consumption and the need for proper insulation to prevent condensation. Careful design 

of the heat sink and water flow system is essential. Overall, the project proves that 

thermoelectric cooling is a viable solution for compact and controlled cooling applications. 
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CHAPTER 6 

CONCLUSION 

 

6.1 Conclusion 

This project successfully develops a smart and reliable three-phase line fault detection system 

with Fire Safety and GSM Notification. It is capable of detecting various faults such as line-

to-line, earth fault, under-voltage, and open/short circuit conditions in real-time. The 

integration of a flame sensor enhances safety by automatically tripping the system during fire 

hazards, preventing serious damage. 

 

The use of a box-based method helps in identifying the fault location and reducing 

troubleshooting time. Additionally, the GSM module ensures instant communication by 

sending SMS alerts with fault details and location, enabling quick response from maintenance 

personnel. 

 

Although the system has some limitations in large-scale applications, it proves to be a cost-

effective and efficient solution for small to medium-level power systems. Overall, the project 

improves system safety, reduces downtime, and enhances reliability, making it highly useful 

for modern electrical protection systems. 

 

6.2 Future Scope 

We are thinking about adding many features to our project in the future to get more desirable 

outcomes. Some of the steps that we are thinking about taking are given below: 

 
 In the future, develop an extra power system (including renewable energy). 

 In future development, this project can be developed with more sensors (Temperature & 

Gas Sensor). 

 In the future, develop wireless communication for remote monitoring and control. 

 In the future, develop an Android Phone IoT System 

 In the future, I will try to apply it in the real field. 
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